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Linter DBMS Data Conversion

Introduction

This document describes Linters database converter, a Linter utility that runs under later MS
Windows operating systems. Is primary function is to transfer table-structured data between
different DBMSs. It isimplemented with the ODBC driver and has a graphic user interface. The

converter is also used to merge or separate data in source and target DBs where source and target
may by in the same or different DBs.
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Overview

The database converter transfers data from a source DB to a target DB. The source and target
DBs may have been created under the same or different DBMSs. The DBMS for both source
and target must have their own ODBC drivers.

During transfer, the following considerations are significant:

e Only data is converted. System level information, such as index and bitmap files, is not
transferred to the target DB.

o During transfer, the program attempts to establish the highest level of data type
compatibility. If the desired level is not achieved, data loss occurs. E.g., if the target DB does
not support BLOB objects, al data containing BLOBswill belost during transfer.

« During view conversion, the data itself is transferred instead of the view text, i.e., atable
that corresponds to a particular view is created.

« During synonym conversion, the converter creates a table corresponding to the specific
synonym.

o Link-integrity rules are transferred to the target DB with the fewest possible aterations.

« During the conversion process, the users privilege access level to both DBs, source and target,
Is checked.
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Linter DBMS Data Conversion

Software Requirements

The Database Converter program runs under the Windows 95/98/NT environment, all of which
include an ODBC driver manage.

ODBC drivers for each DBMS involved in a conversion are provided by the respective DBMS
developers or by third-party devel opers.

Because the conversion process is based on the ODBC driver, any DBMS containing is own ODBC
driver, not just Linter, maybe used as a source or target!
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Starting the Converter Program

Running Converter

To launch the program double-left-click on th
Server program group.

converter program icon in the Linter SQL

Connecting to Databases

When the converter is first run, you will be presented with the Database Connections pop-up
described below.

To perform the data transfer from the source DB to the target DB, the program must connect to
both. These connections must be establisher after the program is launched.

To connect to the Source and Target DBs if the connections are lost or if you skipped the start-up
connection:

1) pressthe F2 key,

2) click onthe connect icon, El or
3) choosethe Database > Connect menu option
to display the Database Connections pop-up.
Databaze connect I

g Select source and target ODEC user data
sOUrce or system data sounce.

Source: ||:IB.&SE Files j

Target: |[MEEEEaR

0K | Cancel | Advanced ‘

Screen 1 — Connecting to Source and Target DBs

You connect to a DB by sdlecting the data resource. The defaults are the DBs used in the last
session. When running the program for the first time the fields will be blank.

To choose the data resource:

1. Left click on the arrowhead button to the right of the Source box to drop down alist of all
dataresources. If the list contains the necessary data source, left-click on its name and go to step
2. Evenif thelist is empty or the source needed is not present, continue with step 2.

2. Left-click on the arrowhead button to the right of the Target box to drop down alist of dl
data resources. Left click the needed target name and click the OK button. Even if the list is
empty or the needed target is not present, click the OK button.

To cancel the selection process click on the Cancel button.
Both the Source and Target fields are required. If one or both are empty, the program will present
you with the ODBC Data Source Administrator window. The tabs on this window alow you to

search for needed data resources, possibly on network nodes. If the search fails, you will be able to
create the needed data resource on the fly.

Data resources are kept in the system registry.
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Linter DBMS Data Conversion

The active tab in the ODBC Data Source Administrator window depends on which box(es), Source
and/or Target, in the Database connect window were empty.

If both fields were left blank, the window will be presented twice: first with the User DSN tab
for the Source, then with the System DSN for him Target. Both tabs show al presently existing
data resources.

The window is displayed with the File Data Source tab active and the contents of the Data Sources
folder displayed (if such is present on the computer).

& 0DBC Data Source Administrator 2=

Usger DSN | System DSH I File DSM I Driversl Trau:ingl Connection F'u:u:ulingl About I

Uzer Data Sources:

MHame | Diriver | - Add...
dEASE Fiies | bdicrozoft dB ase Dnver [*.dbf]

Euncel Files Micrazaft Excel Driver [7 xlz) Bemove |
Ewcel_db icrozoft Ewcel Diriver [7 xlz)

k5 Access Databaze Microzoft Access Driver [7.mdb) Configure. .. |
Wizual FoxPro D atabase Micrazaft Wizual FosPra Driver

Wizual FosPro Tables icrozaft Wisual FoxPro Driver

=

An ODBC User data zource stores information about how to connect o
the indicated data provider. & User data source iz only wisible to you,
and can only be uzed on the current machine.

k., I Cancel Spply Help

Screen 2 — Select Source DB for Conversion

To select afile data source:

1. If the file data source needed is in the current folder left-click on it and its name will be
displayed in the Name column. If the current folder does not contain the needed data source,
use the standard tools to search for it in the local network.

2. |If thesearch for aneeded sourceis unsuccessful click on the Cancel button or initiate the creation
process of anew data source (the Create button).

File data sources usualy haveta.DSN extension.
To select a computer data source:
1. Click the System DSN tab.

2. |If the data source needed is not listed, click the Add button to creste a new data source with
the OBDC driver manager.

3. The Cancel button quits.
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£"10DBC Data Source Administrator ed A

zer DSH  Systerm DSH | File D5 M I Driversl Trau:ingl Connection F'u:u:ulingl Abot I

Swyztem Data Sources:

Driver | fgd.. |

RN =E Linter 5.9 Driver [Unicode]
Bemove |

M ame
Linter 5.

Configure...

A ODBC System data source stores infarmation about how bo connect to
the indicated data provider. A Svstern data source i wigible to all uzers
on thiz maching, including MT services.

k. I Cancel Smply Help

Screen 3 — Select Target DB for Conversion

To create anew file or DSN data source:
1. Click onthe Add button to launch the ODBC-driver manager.
2. Create the new data source with the OBDC driver manager.
The newly created data source(s) will then be available on the File and System DSN tabs.

If, when connecting to a DB, acomputer data source was not chosen, even if it exists, it may be selected
later by returning to the System DSN tab.
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Logging on to the Databases

After defining the data resources, the program connects to the source and target DBs and checks
for necessary access rights. If one or both DBs require the user to log in, the standard login
window is displayed. See Screen 4.

Tologinto aDB under Linter:

1. Enter the username.
2. Enter the password.
3. Sdect the server which contains the DB.
4. Select the language be used.
5. Click the OK button.
x|
User: |SYSTEM o,
Pazzward: I “““““““ Cancel
Server I

" pessimistic

£ autocommit

Screen 4 — DB Login Window

Selecting Tables to be Converted

The data converter allows selective data transfer. The table object selection may performed
according to two criteria: by object type and/or by object parent.

The root window for the converter program, is displayed automatically after a connection is
established. Initialy, it lists all user tablesin the source DB.
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L%?:Dataﬂiver ;IEIEI
File Database Source Wiew Help

25| %% =& 2| »| &

= o] [E] o = el £l

Dwner | M ame | Type |Hemarks| =

(WS |DATA_DEFAULT I

2 |5YS DBA_DATA_FILES TABLE

3 |55 DB& SEGMEMTS TABLE

4 |5Y5 DBA_TABLESPACES  TABLE

B |5YS SESSIOM_PRMS TABLE

B |5YS IISER_CLIUSTERS TABLE

¥ |55 IISER_TABLESPACES TABLE T
8 [SYSTEM $ERALDIT TABLE

3 |5YSTEM $EECOMMEMTS TABLE

10| 5%STEM  $33DEVICE TABLE

11 |SYSTEM  $FFEXTENSION TABLE

12 |5%STEM  $E3EXTREPL TABLE

13 |SYSTEM $33FILTER TABLE

14 |5%STEM  $3$GROUP TABLE

15 |S%STEM  $EELEVEL TABLE

16 |SYSTEM 333PRCD TABLE

17 |SYSTEM $$3PROC TABLE il
Ready L m [

Screen 5 — Converter Main Menu

To select objects to be converted:

Check the System tables checkbox if system tables are to be converted.
Check the Views checkbox if views are to be converted.

Check the Synonyms checkbox if synonyms are to be converted.

Check the All user tables checkbox if al user tables are to be converted.

If only some of the user tables need to be converted, uncheck the All user tables checkbox.
The Like textbox in the Types of object window block will become available.

6. Inthat Like textbox, enter the name of the table(s) you want to convert. The SQL wild card
symbols % and _ may be used to select groups of tables with similar substrings:

= If %<string> is entered, the program will select all the tables whose names end with
<gtring>; e.g., 0N will find al tableswhose names end with ON.

o w0 DN PR

= |If <string>% is entered, the program will select al the tables whose names begin with
<string>; e.g., PB% will find al tables whose names begin with PB.

= If %<string>% is entered, the program will select al tables whose names contain
<string>; e.g., %P_B% will find the tables POBTAB, ARPPB, and CCPKBOL1. To sdlect
table objects by owner’s name, uncheck the All checkbox n the Owners window block.
The Like textbox beneath the unchecked All box will become available. Enter the owner
name(s) in the Like textbox. Wildcards may be used in the same manner asis described
in step 6 in the able immediately above.

The search launched by both Like text boxesis case sensitve.
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Refresh the data displayed in the Source objects window block by pressing F5, clicking on the
refresh icon, or by selecting the Source > Refresh menu option.

After sdecting your tables, the Source objects window block will contain a listing of selected
objects. Thislisting is not fina and may be modified later on.

Data Type Compatibility

Data type compatibility problems may arise when transferring data from one DB to ancther.
Data types may be incompatible in the following instances:

1. The target DB does not support one or more of the data types used in the source DB. E.g.,
FoxPro does not support BLOB datawhichisincluded in Linter;

2. Inconsistencies between lengths of data types ,e.g., Linter’s char data type may extend to
4000 symbols while other DBs may support only 256;

3. Incompatibility of fixed point number precision.
The converter compares the data types and creates the maximum level of compatibility. You
may edit the derived compatibility list:
1. Inthe Converter Main Menu window, Screen 1, press F9 or choose the Source > Options >
Data types menu option.
2. When editing is complete, click the OK button.

options x|
Data tppes | Object settings I Mode settings I Interface I
Uze uzer configuration profile; <DEFALLT >
Source and target data bypez mapping
| Source | T arget (==
P [NCHAR VARYING [MCHAR YARYING
_ 2 |MCH&R MCHAR
3 |BOOLEAM BOOLEAMN
4 |BIGINT BIGINT
EBIGINT AUTOIMC BIGINT AUTOINC
_ B |BLOB ELOE
7 WARBYTE WARETTE
8 |BYTE BYTE
9 |CHARACTER CHARACTER
10 |EXTFILE CHARACTER
11 |DECIMAL CECIMAL
12 |INTEGER INTEGER
EINTEGEH AUTOINC IMTEGER AUTOIMNC
14 |SMALLINT ShalLIMT (.
15 [SMALLINT AUTOIMNC ShAaLLIMT AUTOIMC
1E |REAL REAL
17 |DOUBLE DOUBLE -
Advanced »» |
ak. I Cancel Apply

Screen 6 — Data Type Compatibility Window
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Standard Data Conversion

To launch the standard conversion:

1. Select those tables in the Source object window block of the Converter Main Menu
window, Screen 5, that are to be converted. To select an table, left-click on its name. The
selected table object name will be highlighted in black.

2. Tosdectdl of thelisted table objects, choose the Source > Select all menu option.
3. Tocanced dl sdections, select the Source > Desdlect al menu option.

4. PressF4, choosethe Database > Convert menu option, or click on the propertiesicon El

Tools and Options to Modify Conversion

If the conversion generated by the program is not satisfactory, specific column properties of both
the source and target may be modified or any table being converted.

To edit or establish the conversion parameters:

1. Select the source table (even if you want to work on the target table) to be used in the transfer
by clicking on the table name in the list in the Converter Main Menu window, Screen 5. The
selected table will be highlighted in blue.

2. PressAlt+Enter, sdlect the Source > Properties menu option, or click the_I icon.
You will then have the Edit Table Properties window, Screen 7.

Properties of the [Linter 5.9 Unicode JFINANCE il

Colurns | Data previewl Targetl [rata copying schemal I:Dnl:liticunl Cluery I

Name | Type |Slze| Digit |
CROITCRD ]

CROITLIM  INTEGER 10 0
CURMTB&AL INTEGER 10 0
OILCRD CHARACTER 7 MULL
METWORTH IMNTEGER 10 0
CROITRAT  IMTEGER 10 0
INSCMPNY  CHARACTER 25 MHULL
FLCYAMNT  INTEGER 10 0
COLLEGE CHARACTER 16  MULL
OMWACTH CHARACTER 1 HULL
INYSTMNT  CHARACTER 15 HULL
BAME. CHARACTER 30 MULL
FERSOMID  INTEGER 10 0

00| == | I (O e | OO D | e

(]

—
(s}

—_
—_

—_
I~

—_
(T8}

] 4 I Cancel Apply

Screen 7 — Edit Table Properties
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The functions available for the six tabsin this screen are explained n the following sections. In the
examplein Screen 7, the Columns tab has been sel ected.

View Source Table Structure

To view the source table's structure, select the Columns tab on the Edit Table Properties window,
Screen 7. The following properties for each column in the table are displayed:

1) the name of the column;
2) itsdatatype;

3) itslength or precision;
4) itsscae.

Preview Data to be Transferred

To preview the data being transferred, select the Data preview tab on the Edit Table Properties
window, Screen 1.

A window containing column names and column data for each row of the selected table object will

be displayed.
x|
Columns  Data preview |Target| [rata copying schemal I:::unu:liticunl Cluery I
CADITCRD | CRDITLIM| CURNTBAL| OILCRD | NETWORTH| CRDITRAT =
[ JEHERICAN EXPRESS 300 800 JARCO 5
2 |CARTE BLANCHE 400 1000 GULF 1620 5
3 |MASTER CHARGE 500 5 SHELL 1640 7
4 |BANK AMERICARD 500 10 Ex<ON 16D g
5 |DINERS CLUB 700 20 BP 1680 g
B [AwIS 800 50 AMOCO 1700 10
7 |[HERTZ 500 E0 TEXACO 1720 1
8 |UNITED AIR TRAYEL 1000 E5 CGO 1740 2
g |AMOCO TORCH CLUE 1100 80 SUMOCO 1760 3
10 |4MERICAN EXPRESS 1200 g5 CROWN 1780 4
11 |CARTE BLANCHE 1300 100 SOHIO 1800 5
12 |MASTER CHARGE 100 125 ARCO 1820 5
13 [BAMK AMERICARD 200 500 GULF 1840 7
14 |DINERS CLUE 300 E50 SHELL 1860 8
15 [&w15 400 800 Ex<ON 1880 g
16 |HERTZ 500 1000 BP 1300 10
17 |UNITED &IR TRAVEL 500 5 AMOCO 1920 1 _
1 AACITO TODCU SLLID 0N in TCW AT 104N 2
i o
0k, I Cancel | Apply |

Screen 8 — Preview Data to be Transferred

Modifying the Target Table’s Structure

In standard conversion mode, Linter generated compatibility data types are used to set the target
table's data types. Integrity constraint properties are not transferred from the source DB to the
target DB, except for AUTOINC.
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To establish column properties for the newly created target table, you may set column properties
in the target DB after the conversion process. In DBs other than Linter, this post-transfer
techniqueissimilar o LintersALTER TABLE function.

An aternative method is to set the target properties by declaring hem in the conversion program.

If the target tableisto be anew table, i.e, datais not to be written into a pre-existing table, you may
change the target column propertiesinitially created by the convert program.

In this context, a column property refers to those characteristics of histable that include the table
name and, for any column:

1) column name;
2) datatype;
3) precision or length of data, depending on data type;
4) thescdefor scalable numeric datatypes,
5) primary key status,
6) theintegrity constraints:
= theoptional default value for each column;
=  AUTOINC (automatic incrementing);
= NULL |NOT NULL; and
=  UNIQUE.

To access these new-target-table editing functions, click the Target tab on the Edit Table
Properties window, Screen 7.
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Properties of the [Linter 5.9 Unicode JFINANCE 5[
Enlumnsl Data preview T arget | Drata copying schemal I:::unu:liticunl e I
" Existing objec Ovares | M arrie | Tupe | Remarks| -
4 —1
28 |SYSTE P TABLE
29 |5vSTE PERSOM TAELE
30 |SvSTE PRIV_TYFES TAELE -

*' Mew object; Igales_urder

T arget columns:

M ame | Type | Size| Drigyit | Frimany ke_l,ll Other | Add
14 INTEGER 0 HMULL [
2 |eust_id INTEGER 0o 0 —
3 |coder_date  DATE o 0 —
4 |in code_jd  CHARACTER 00 ]
15 | region CHARACTER 0 1 —
b [sales rep  [INTEGER 0 0 —
OF. Cancel Apply

Screen 9 — Edit New Target Table Properties

Note that the target's columns are listed in a column headed Name.

In the example in Screen 9, note that the New object radio button has been selected. If this button is
not selected, the structure editing functions for a new target table are not available.

The Exist object button is selected for wring data into a preexisting table as described in “Paste
Datainto an Existing Table’.

Change Target Table Name

1.
2.
3.
4.

Select the Target tab on the Edit Table Properties window, Screen 7.

Select the radio button New option.

Click the cursor in the text box to the right of New option and edit the table name.
Click the Apply then OK buttons.

Change Column Names in Target Table

1
2.
3.

Select the Target tab on the Edit Table Properties window, Screen 8-7.
Select the radio button New option.

In the Target columns window block, click the cursor in the field with the column name you
need to change.

Edit the column name.
Click the Apply then OK buttons.
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Change Column Data Type

As described in “ Standard Data Conversion” and “Tools and Options to Modify Conversion”
sections, the converter uses either data type compatibility generated by the program or one
defined by the user.

In either case, thisfunction alows you to select anew datatype for a target column:

1. Sdect the Target tab on the Edit Table Properties window, Screen 7, to display the column
properties of the selected table in the target DB.

2. Inthe Target columns window block, select the TYPE_NAME field of a column for which
anew datatypeisrequired.

3. Click onthe arrowhead icon at the right of the TYPENAME field. From the drop down list of
data types, choose the one you need to use in the conversion process.

4. Repeat steps 2 and 3 for all the columns that need to have their data type compatibility
modified.

When you have finished all the changes, click Apply and then OK.

Change Column Length or Precision
To modify the length or precision of atarget column:

1. Select the Target tab on the Edit Table Properties window, Screen 7, to display Column
properties of the selected table in the target DB.

2. Select the Precision field of the column to have its length or precison changed in the Target
columns window block.

3. Typeinthe new length or precision of the column.
When all necessary length and precision changes have been made, click the OK button.

Note that both length and precision are handled in the column headed Precision.

Change Column Scale
To modify atarget column's scale:

1. Select the Target tab on the Edit Table Properties window, Screen 7, to display Column
properties of the selected table in the target DB.

2. In the Target columns window block, select the Scale field of the DECIMAL data type
column to have its scale changed.

3. Typein the new scale of the column.
When all columns have the necessary scale changes made, click he OK button.

Set or Unset a Primary Key Column
To modify atarget primary key status:
1. Select the Target tab on the Edit Table Properties window, Screen 7, to display column
properties of the selected table in the target DB.

2. A checkmark in the checkbox in the Primary key column of the Target columns window block
indicates the selected target table’s column is a primary key for the target table.

3. lick on acheck box to toggle the checkmark on and off.
Click the OK button to complete the change.
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Set Column Constraint Properties in Target
To set column constraints:

1

Select the Target tab on the Edit Table Properties window, Screen 7, to display column
properties of the selected tablein the target DB.

Click the Other column in the Target columns window block opposite the target file's
column name for display column properties of the selected table in the target DB.

Type in the column constraint(s) being declared. If more than one, a space separates each
constraint. The values entered must be in the declaration syntax of the target DB. For
example, if the target DB is Linter, the following vaues are permitted: DEFAULT<vaue>,
AUTOINC, NULL | NOT NULL, and UNIQUE.

The column constraints must be declared in the vocabulary of the target DB. An eror wil only be
discovered when the conversion files.

Change Number of Columns in a Target Table
You may add columns to or exclude columns from the target table.

To add new columns during transfer:

1.

Select the Target tab on the Edit Table Properties window, Screen 7, to display column
properties of the selected table in the target DB.

Click the Add button to the right of the Target columns window block. A new, blank row
will be appended to the list of columns,

In this blank row, type in the properties of the new column.
Repeat steps 3 and 4 as many times as necessary.
Click Apply and OK.

To exclude columns from the transfer process:

1.

2.
3.
4.

Select the Target tab on the Edit Table Properties window, Screen 7, to display column
properties of the selected table in the target DB.

Select the column to be excluded and click the Delete button.
Repeat step 2 as many times as necessary.
Click Apply and OK.

Change Column Transfer Scheme

Unless changed with this function, a source table column is always copied to a target table column
with the same name. You may wish to change this pattern i, for example, you are adding new
columnsto the target table, and all or some of the columns from the source table can be copied to
the newly added columns.

To modify the transfer scheme, select the Data copying scheme tab on the Edit Table Properties
window, Screen 7 to bring up this unction.
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Properties of the [Linter 5.9 Unicode JFINANCE

Enlumnsl [rata previewl Target Data copying schema I I:::unu:liticunl e I

il

Source | Target | Drefault
L CROITCRD d
_ 2 |CRDITLIM cuzt_id Clear
3 |CUBNTBAL coder_date
4 |OILCRD fn_code_id
3 |METWORTH Fengia
» |CROITRAT | El
i INSCHPHY d
i FLCYAMMT cuzt_id
3 |COLLEGE coder_date
10 | ONVACTN fr_code_id
1 INVSTMNT reqgion
12 |BANK
i FERSOMID

0k, I Cancel Apply

Screen 10 — Change Transfer Scheme

The Source column lists the columns of the source table. The Target column lists the columns of
the target table. Initially, they correspond to each other.

To exclude a column from the transfer, select the column in question in the Target list and click
Clear.

To specify a source column for a specific target column, select a column name in the Target column
list. Click on the icon that appears to the right of the target column name after you have selected
it. Select the desired source column from the drop down list.

The Default button restores the default scheme and |eaves the window open.
The Cancel button cancels al the changes and closes the window.

Link Integrity

Link integrity may only be transferred when both the source and target DBs support link
integrity rules.

To transfer link integrity, select the References tab on the Edit Table Properties window, Screen
7 to bring up this function.
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Properties of the [Linter 5.9 Unicode ]TAB1 5[

Columns  Feferences |Data previewl Targetl Data copying schemal E-:unu:litiu:unl [uem I

Dependent tables
P tal:ulel P -:u:ulumn| FE. u:u:ulumn| FE. name | P¥. name | Llpu:late|
» _ _ STSTEM_TABT_| fPRIMARY KEY
1| | ’
Drefault |

ok, Cancel Spply

Screen 11 — Link Integrity

To exclude alink from the transfer select it and click the Delete
To restore link integrity to isinitial sate, click the Default button.

Since some incompatibilities exist between current and SQL Standard link syntax versions, it
may be necessary to modify the expressions that create links. To access the link integrity
function, press the F9 key or choose the Source > Options > References menu option.

The Options window will then be displayed with the References integrative tab active. Select the
SQL expresson templates you need to create primary keys, foreign keys, and/or table
modifications (ALTER TABLE) from the choices displayed.
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options |

Data types  Dbject settings | Mode settingsl Interfacel

— Cluery
Dbject creation and alteration options:

create table [col_name <tppesr primary key, ..
[ create table [col_name <types, ... primary key [key_name]]
[ create table [col_name <typer. ... constraint pk_name primary key [key_nan

— |nteqgrity conztraing
Support primary and foreign keys

¥ Primary key process

¥ Reference integrity constraints process

[refault |
0k, I Cancel | Apply |

Screen 12 — Link Integrity Syntax Rules

If links are not to be supported uncheck the Support references integrative box.
Click on the OK button to save the changes, the Cancel button to quit without saving changes.

Sorting Data

During the transfer the data may be stored in the receiving table in a different order from the
source table.

The sorting function is accessed from the Edit Table Properties window, Screen 7, by clicking
the Other tab.
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Properties of the [Linter 5.9 Unicode JPERSON

Enlumnsl [rata previewl Targetl Data copying zchema  Condition I e I

Source columng gorting order

Colurmn J Azcending |

’

X
Add
v Delete |
FIRSTHAR
IMITIALS
SEX

AGE
FMLYETAT

NEPRIOKITE

Wihere clauze:

Kl

i

0k, I Cancel | Apply

Screen 13 — Modify Column Sorting Order

To modify the sort:
1. Click onthe Add button to the right of the Source column sort order window block.
2. Click the down arrowhead button to the right of the text box below the word “ Column”.
3. Select the column to be used as a starting point for the sort from the drop down list.
4. A checkmark in the box below the word Ascending, indicates the sort is to be in ascending
order. Uncheck the box, by clicking on it, to select a descending sort.
5. Repeat steps 1 - 4 for additional sorting columns,
6. Click the Apply and OK buttons when you are satisfied.

To remove a column included by mistake, select it and click the Delete Button.

Selective Data Transfer

Selective transfer allows you to transfer only those pars of the source table that contain valid
data. Conditions, in the syntax of WHERE and SELECT clauses, may be applied to relevant
columns to exclude obsolete or otherwise invaid data The WHERE and SELECT keywords are not

ncluded in these condition statements.

To access this utility, shown above in Screen 13, choose the Source > Properties > Other menu
option from the Converter Main Menu window, Screen 5. Click the Other tab on the Edit Table
Properties window, Screen 7.

To set the selection criteria

1.

Select the column to which a condition is to be applied from the drop down menu under the
word Column.
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2. Type in the WHERE or SELECT statement in the Condition text box. Keywords are not
included in your text.

3. When you have entered all the needed conditions, click the Apply and then OK buttons.

Paste Data into an Existing Table

Pasting data into an existing table is afunction used to merge or separate data in the source and
target DBs.

When transferring data to a pre-existing target table, data type compatibility issues are resolved
based on the target table. You cannot modify the data types of pre-existing target tables.

When the target table has been created with all of its properties (indexed columns, primary and
secondary keys, etc.) defined, this

Function checks the target table's data types and other properties. The data type of data written
into the target table is converted into the data type required by the target table.

To paste into an existing table, Open the Edit Table Properties window, Screen 7 and select the

Target tab.
Properties of the [Linter 5.9 Unicode]S El

I::::Iumnsl Heferencesl Diata previews  Target | [ata copying Schemal I:::unu:liticunl Cluery I

@ Existing oblec [ | Qumer| MName | Type | Remarks| =
» SEE S T .
33 |5vSTE SERVERS TABLE —
a4 |5¥STE 5P TABLE
35 |SY'STE TR_DATA TABLE .

i~ Mew object; IS

Target columns:

M ame | Type | Size| Dhigit | Prirary ke_l,l| Elther|

SHUM  |[CHARACTER 5  HWULL
SMAME CHARACTER 20 HWULL
STATUS INTEGER 10 0

CITY CHARACTER 15 MULL

fdd
[elete |

[=[w|~
Joo®

k. I Cancel Apply

Screen 14 — Select Existing Target Table for Paste

1. Select the Existing object radio button.

2. Select the source table from the list in the Exist object window block. The target table's
column list, and properties, will be displayed in the Target columns window block.

3. Click the OK button to accept the structure.

Page 22



Linter DBMS Data Conversion

If your review of the target table's properties indicates that there is a data type mismatch, close
the window and edit the data type of the source table as described in §8.5.

After clicking the OK button, initiate the transfer with F4, choosing the Database > Convert
menu option, or clicking theil icon on the Main Menu, Screen 5.

Runtime Errors
During execution, the converter performs the following checks:
1) validity of parameters and operations set by the user;

2) the possibility of transferring data from the source to the target DB in according to
predefined rules;

3) situations which can cause dataloss.
When these checks locate a problem a diagnostic message is displayed:

x

Can not copy data from SYSTEM.F to SYSTERM.F
[Relex][Linter ODBEC Diriver] SELE xecute: #3903 duplicate walue for primary
ar unique key #303

[ Do not open this emor meszage box, ignore all erors and warnings.

| Abart I lgnare Detail =

Screen 15 — Preliminary Diagnostic Window

The choices are:

Abort The conversion is halted. The data already transferred is
saved inthetarget DB

Ignore Continue with transfer, ignoring first messagein list.

Ignoreall Continue with transfer, ignoring al messages.

Moreinfo Show SQL query text in which error occurred.

The options in the More info window are the same except that the More info button here
returns you to the Preliminary Diagnostic Window.
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x

Can not copy data from SYSTEM.F to SYSTERM.F
[Relex]Linter ODEC Driver] SOLE secute: #3903 duplicate walue for primary
ar unique key #3903

™ Do not open thiz emar mezzage box, ignore all erors and warnings.

| Abort | Ignare | | Distail <<

inzert inta "STYSTEM" P ["PHUM""PHAME" "COLOR", WEIGHT" "CITY" ;I
walues [7,7,70.70.7]

[F1', 'Peps', ted’, 12, 'London']

Screen 16 — More Info Diagnostic Window

View Source and Target Information

To see information about the source or target DB, press F3 key or select Database > General

information.
x
Source | Targetl
| Parameter | Walle | | =
b [DEMS name [Linter
2 |DBMS wersion 05.03.0028
3 |ODBC driver name intodb51 dl
4 |0DBC version 0251
i ODEC driver werzion 03.00E100
B |ALTER TABLE 1 |
7 |COLUMM ALIAS Tes
8 |CORRELATION MAME 2
3 |EXPRESSIONS IM ORDEREY Yes
10| GROUP BY K]
11 |IDENTIFIER CASE 3
12 /IDEMTIFIER QUOTE CHAR -
13 KEYWORDS ABSOLUTE ACTION ADA AL
14 |LIKE_ESCAPE_CLALSE Tes -

Screen 17 — View Source and Target Information
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View Statistics

After execution, the program shows statistical information about the work done under two tabs.
The Statistic tab displays:
For every table  the number of columns, row, and links processed, the time elgpsed for each
operation, and the completion status.

Summary data  number of tables processed, number of errors, and the SQL query list tab
displays al queries evaduated during execution.

statistics x|
Statistic | SOL - queny list | Erors |
SERYERS => SERVT B
SERVER_ID -» SERVER_ID
FLAGS -» FLAGS

SERVER_MAME -: SERVER_MAME
LAST_COMMECT -» LAST_COMMECT

Colurnz < 0

Faowes: 1

References : 0
Ewecution time ; 00:00.00
Status : Ok

Tahbles: 1
Errorz: 0
Tirne tatal : 00:00.00

K ]
v Show statistic window

Screen 18 — View Statistics
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statistics x|
Statistic SHL - gueny list I Ermars I
SUSYSTEM™ "SERVERS" =/ ;I
create table "SERVT[MSERVER_ID" SMALLIMT “FLAGS" SMALLIMT "SERVER_MAME" CHARACTER
zelect "SERVER_ID" "FLAGS" "SERVER_MaME" "LAST_COMMECT" from "SYSTEM" "SERVERS"/ |
inzert into "SERVTY [MSERVER_ID","FLAGS","SERVER_MAME","LAST _COMMECT"] walues [7.7,7,7)"
1 | i

¥ Show statistic window

Screen 19 — View SQL Queries
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